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iIntroduction
Welcome! This Step by Step book has been designed so you can read it from the 
beginning to learn about Microsoft Project 2016 and then build your skills as you 
learn to perform increasingly specialized procedures. Or, if you prefer, you can jump 
in wherever you need ready guidance for performing tasks. The how-to steps are 
delivered crisply and concisely—just the facts. You’ll also find informative, full-color 
graphics that support the instructional content.

Who this book is for
Microsoft Project 2016 Step by Step is designed for use as a learning and reference 
resource by home and business users of Microsoft Office programs who want to use 
Project to create and manage projects more efficiently. The content of the book is 
designed to be useful for people who have previously used earlier versions of Project 
and for people who are discovering Project for the first time.

The Step by Step approach
The book’s coverage is divided into chapters representing general Project skill sets.  
Each part is divided into chapters representing skill set areas, and each chapter is 
divided into topics that group related skills. Each topic includes expository information 
followed by generic procedures. At the end of the chapter, you’ll find a series of practice 
tasks you can complete on your own by using the skills taught in the chapter. You can 
use the practice files that are available from this book’s website to work through the 
practice tasks, or you can use your own files.
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Download the practice files
Before you can complete the practice tasks in this book, you need to download the 
book’s practice files to your computer from http://aka.ms/project2016sbs/downloads. 
Follow the instructions on the Downloads tab.

IMPORTANT  Project 2016 is not available from the book’s website. You should install 
that program before working through the procedures and practice tasks in this book.

You can open the files that are supplied for the practice tasks and save the finished 
versions of each file. If you later want to repeat practice tasks, you can download the 
original practice files again.

The following table lists the practice files for this book.

Chapter Folder Files

Part 1: Get started with Microsoft Project
1: Project, project management, and you Ch01 None

2: Take a guided tour Ch02 TakeGuidedTour.mpp

Part 2: Simple scheduling basics
3: Start a new plan Ch03 None

4: Build a task list Ch04 SimpleBuildTaskList.mpp

5: Set up resources Ch05 SimpleSetUpResources.mpp

6: Assign resources to tasks Ch06 SimpleAssignCheckPlan.mpp 
SimpleAssignControlWork.mpp 
SimpleAssignCostResource.mpp 
SimpleAssignWorkResource.mpp

7: Format and share your plan Ch07 SimpleFormat.mpp

8: Track progress: Basic techniques Ch08 SimpleTrackActuals.mpp 
SimpleTrackBaseline.mpp

Part 3: Advanced scheduling techniques
9: Fine-tune task scheduling Ch09 ScheduleTasksAdvanced.mpp 

ViewTaskPath.mpp

10: Fine-tune task details Ch10 FineTuneTasks.mpp

11: Fine-tune resource and assignment  
     details

Ch11 FineTuneAssignments.mpp 
FineTuneResources.mpp

xiv
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Chapter Folder Files
12: Fine-tune the Project plan Ch12 FineTunePlan.mpp

13: Organize plan details Ch13 OrganizeDetails.mpp

14: Track progress: Detailed techniques Ch14 RescheduleIncompleteWork.mpp 
TrackTimephasedWork.mpp 
TrackWork.mpp 
UpdateBaseline.mpp

15: View and report project status Ch15 ReportStatus.mpp

Part 4: In-depth and special subjects
16: Format and print views: In-depth  
      techniques

Ch16 FormatInDepth.mpp

17: Format reports: In-depth techniques Ch17 FormatReportsInDepth.mpp

18: Customize Project Ch18 CustomizeProjectA.mpp 
CustomizeProjectB.mpp

19: Share information with other programs Ch19 SampleTaskList.xlsx 
ShareInformation.mpp

20: Consolidate projects and resources Ch20 ConsolidatePlansA.mpp 
ConsolidatePlansB.mpp 
ShareResourcesA.mpp 
ShareResourcesB.mpp

Ebook edition
If you’re reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at 
http://aka.ms/project2016sbs/detail.
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Adapt procedure steps
This book contains many images of the Project user interface elements (such as the 
ribbon and the program window) that you’ll work with while performing tasks in  
Project on a Windows computer. Depending on your screen resolution or window 
width, the Project ribbon on your screen might look different from that shown in 
this book.(If you turn on Touch mode, the ribbon might display some commands in 
a different layout.) As a result, procedural instructions that involve the ribbon might 
require a little adaptation.

Simple procedural instructions use this format:

1.	 On the Task tab, in the View group, click the Gantt Chart button.

If the command is in a list, our instructions use this format:

1.	 On the View tab, in the Data group, click the Filter arrow and then, in the Filter 
list, click Summary Tasks.

If differences between your display settings and ours cause a button to appear differ-
ently on your screen than it does in this book, you can easily adapt the steps to locate 
the command. First click the specified tab, and then locate the specified group. If a 
group has been collapsed into a group list or under a group button, click the list or 
button to display the group’s commands. If you can’t immediately identify the button 
you want, point to likely candidates to display their names in ScreenTips.
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Multistep procedural instructions use this format:

1.	 On the View tab, in the Resource Views group, click the Resource Sheet button 
to display the Resource Sheet view.

2.	 On the View tab, in the Data group, click the Tables button, and then click Cost.

The instructions in this book assume that you’re interacting with on-screen elements 
on your computer by clicking (with a mouse, touchpad, or other hardware device). If 
you’re using a different method—for example, if your computer has a touchscreen 
interface and you’re tapping the screen (with your finger or a stylus)—substitute the 
applicable tapping action when you interact with a user interface element.

Instructions in this book refer to Project user interface elements that you click or 
tap on the screen as buttons, and to physical buttons that you press on a keyboard 
as keys, to conform to the standard terminology used in documentation for these 
products.

When the instructions tell you to enter information, you can do so by typing on a 
connected external keyboard, tapping an on-screen keyboard, or even speaking 
aloud, depending on your computer setup and your personal preferences.
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Get support and give feedback
This topic provides information about getting help with this book and contacting us 
to provide feedback or report errors.

Errata and support
We’ve made every effort to ensure the accuracy of this book and its  
companion content. If you discover an error, please submit it to us at  
http://aka.ms/project2016sbs/errata.

If you need to contact the Microsoft Press Support team, please send an email  
message to mspinput@microsoft.com.

For help with Microsoft software and hardware, go to http://support.microsoft.com.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress.

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at http://twitter.com/MicrosoftPress.
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3Start a new 
plan

In this chapter
■■ Create a new plan and set its 

start date

■■ Set nonworking days in the 
project calendar 

■■ Enter the plan title and other 
properties 

Practice files
No practice files are necessary to 
complete the practice tasks in this 
chapter.

A project’s schedule or plan is essentially a model that 
you construct of some aspects of a project you are 
anticipating—what you expect will happen, or what you 
want to happen. This model focuses on key aspects of a 
project, such as tasks, resources, timeframes, and pos-
sibly their associated costs. Note that throughout this 
book, we’ll refer to the types of documents that Project 
2016 works with as plans, not documents or schedules.

This chapter guides you through procedures related to 
creating a new plan and setting its start date, setting 
nonworking days in a project calendar, and entering a 
plan’s title and other properties.
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Create a new plan and set its start date
As you might expect, Project focuses primarily on time. Sometimes you might know 
the expected start date of a project, the expected finish date, or both. However, 
when working with Project, you specify only one date, not both: the plan’s start date 
or finish date. Why? Because after you enter the plan’s start or finish date and other 
details, Project calculates the other date for you. Remember that Project is not merely 
a static repository of your schedule information or a Gantt chart drawing tool—it is an 
active scheduling engine.

Most plans should be scheduled from a start date, even if you know that the plan 
should finish by a certain deadline date. Scheduling from a start date sets all tasks to 
begin as soon as possible, and it gives you the greatest scheduling flexibility. In this 
and later chapters, you will see this flexibility in action as you work with a plan that is 
scheduled from a start date.

To create a new plan

1.	 In Project, if the File tab is displayed, click it, and then click New.

2.	 In the list of templates, click Blank Project or any other template you want.

Or

1.	 If you already have a list of available templates on the Start screen, click Blank 
Project or any other template you want.

When you create a new plan, Project sets the plan’s start date to the current 
date. Project draws a thin green vertical line in the chart portion of the Gantt 
Chart view at the current date. 

The current date is shown in the Gantt Chart view; look for the green vertical line (your current date 
will likely differ)
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To set (or change) the plan’s start date

1.	 On the Project tab, in the Properties group, click Project Information.

2.	 In the Project Information dialog box, in the Start Date box, enter the start 
date you want or click the arrow to select one from the calendar.

TIP  In the calendar, you can use the left and right arrows to navigate to any 
month and then click the date you want, or click Today to quickly choose the 

current date. 

3.	 Click OK to accept the start date and close the Project Information dialog box.

To save the new plan

1.	 Click the File tab, and then click Save As.

2.	 On the Save As page, navigate to the location where you want to save the plan. 

TIP  You can adjust Project settings related to files. For example, you can set 
Project to automatically display the Project Information dialog box each time 

you create a new plan. To make this change, click the File tab, and then click Options. 
In the Project Options dialog box, click Advanced, and then, in the General section, 
select the Prompt For Project Info For New Projects check box. You can also instruct 
Project to automatically save the active plan at predefined intervals, such as every 10 
minutes. In the Project Options dialog box, click Save, select the Auto Save Every check 
box, and then specify the time interval you want.

Set nonworking days in the project calendar 
Calendars are the primary means by which you control when each task and resource 
can be scheduled for work in Project. In later chapters, you will work with other types 
of calendars; in this chapter, we focus on the project calendar.

The project calendar defines the general working and nonworking days and times for 
tasks. Project includes multiple calendars, called base calendars, any one of which can 
serve as the project calendar for a plan. You select the base calendar that will be used 
as the project calendar in the Project Information dialog box.
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Set the plan’s start date, project calendar, and other essential schedule settings in the Project Information 
dialog box

IMPORTANT  If you are using Project Professional rather than Project Standard, the 
Project Information dialog box and some other dialog boxes contain additional options 

relating to Project Server. For more information about Project Server, see Appendix C, “Col-
laborate: Project, SharePoint, and PWA.”

The Calendar list contains the three base calendars that are included with Project: 

■■ 24 Hours  Has no nonworking time 

■■ Night Shift  Covers a late-night “graveyard” shift schedule of Monday night 
through Saturday morning, 11:00 P.M. to 8:00 A.M., with a one-hour break each 
day 

■■ Standard  The traditional working day and week, Monday through Friday from 
8:00 A.M. to 5:00 P.M., with a one-hour break each day 

Only one of the base calendars serves as the project calendar; the Standard calendar 
is the default. 

Think of the project calendar as your organization’s normal working days and hours. 
For example, this might be Monday through Friday, 8:00 A.M. through 5:00 P.M., 
with a one-hour lunch break each day. Your organization or specific resources might 
have exceptions to this normal working time, such as holidays or vacation days. You’ll 
address resource vacations in Chapter 5, “Set up resources.”

You customize calendars in the Change Working Time dialog box (which opens when 
you click the Change Working Time button on the Project tab).
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Customize a calendar’s working time in the Change Working Time dialog box

Use this dialog box to set normal working schedules and working time exceptions 
for individual resources or the entire plan. Other common examples of working time 
adjustments include: 

■■ Recurring holidays or other times off that follow a known pattern, such as 
weekly, monthly, or annually. 

■■ Variable working times per week; for example, to address seasonal changes in 
working times. 

■■ Unique working hours for a resource. You’ll make such settings in Chapter 5, 
“Set up resources.”
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To select the project calendar

1.	 On the Project tab, in the Properties group, click the Project Information 
button. 

2.	 In the Project Information dialog box, in the Calendar box, click the arrow, and 
then click the calendar you want to use as the project calendar.

To set a specific date as nonworking

1.	 On the Project tab, in the Properties group, click the Change Working Time 
button. 

2.	 On the Exceptions tab in the lower portion of the Change Working Time 
dialog box, in the Name field, enter a description of the exception.

TIP  You don’t need to name calendar exceptions, but it’s a good practice for 
you or others to identify the reason for the exception.

3.	 In the Start and Finish fields, enter or select the dates you want.

4.	 Click OK.

To set up a recurring nonworking time

1.	 On the Project tab, in the Properties group, click the Change Working Time 
button. 

2.	 On the Exceptions tab of the Change Working Time dialog box, in the Name 
field, enter a description of the recurring exception.

3.	 Click in the Start field, and then click Details.

4.	 In the Details dialog box, under Recurrence Patterns, select the recurrence 
values you want, and then click OK.

5.	 Click OK to close the Change Working Time dialog box.

To set up a custom work week

1.	 On the Project tab, in the Properties group, click the Change Working Time 
button. 

2.	 Click the Work Weeks tab in the lower portion of the Change Working Time 
dialog box.

3.	 Click a row below the “[Default]” value.

4.	 Enter a description and the date range for which you want the custom work 
week to apply. 
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5.	 In the Start and Finish fields, enter or select the date range for which you want 
the custom work week to apply.

6.	 Click Details.

7.	 In the Details dialog box, select the day and time values you want, and then 
click OK. 

8.	 Click OK to close the Change Working Time dialog box.

Enter the plan title and other properties
Like other Microsoft Office apps, Project keeps track of several document properties. 
Some of these properties are statistics, such as how many times the document has 
been revised. Other properties include information that you might want to record 
about a plan, such as the project title, the project manager’s name, or keywords to 
support a file search. Some of these properties are used in views, in reports, and in 
page headers and footers when printing. You can view and record these properties in 
the Properties dialog box.

Record useful summary information about a plan in the Properties dialog box
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To enter a plan’s properties

1.	 Click the File tab, and then click Info. 

2.	 On the right side of the Info screen, click Project Information. In the menu that 
appears, click Advanced Properties. 

3.	 Enter whatever properties you want to record (all are optional), and then click OK.

Project management focus: Project is part of 
a larger picture
Depending on your needs and the information to which you have access, 
the plans that you develop in Project might not deal with other important 
aspects of your projects. For example, many large projects are undertaken 
in organizations that have a formal change-management process. Before 
a major change to the scope of a project is allowed, it must be evaluated 
and approved by the people managing and implementing the project. Even 
though this is an important project-management activity, it is not something 
done directly within Project.

Skills review 
In this chapter, you learned how to:

■■ Create a new plan and set its start date

■■ Set nonworking days in the project calendar 

■■ Enter the plan title and other properties
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Practice tasks
No practice files are necessary to complete the practice tasks in this 
chapter.

IMPORTANT  If you are running Project Professional with Project Web App/Project 
Server, take care not to save any of the practice files you work with in this book to 

Project Web App (PWA). For more information, see Appendix C, “Collaborate: Project,  
SharePoint, and PWA.”

Create a new plan and set its start date
The scenario: Throughout this book, you’ll play the role of a project manager at 
Lucerne Publishing, a book publisher that specializes in children’s books. Lucerne is 
about to publish a major new book, and you’ve been asked to develop a plan for the 
book launch. Start Project, and perform the following tasks:

1.	 Create a new plan based on the Blank Project template.

2.	 Set the new plan’s start date to January 8, 2018.

3.	 Save the new plan as Simple Plan in the Project2016SBS\Ch03 folder.

Set nonworking days in the project calendar
The scenario: At Lucerne Publishing, you need to account for an upcoming date on 
which the entire Lucerne staff will be unavailable to work on the book launch project.
Continuing in the Simple Plan plan, perform the following task:

1.	 In the project calendar, create a nonworking day calendar exception named 
Staff at morale event for January 25, 2018. 
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The calendar exception you created should look like this in the Change Working Time dialog box

Enter the plan title and other properties
The scenario: You want to record top-level information about the new book launch 
plan. These details won’t affect the overall schedule but relate to important supple-
mental information you want to keep in the plan. Continuing in the Simple Plan plan, 
perform the following task:

1.	 Give the Simple Plan the following properties:

●● Subject: New book launch schedule 

●● Manager: Carole Poland

●● Company: Lucerne Publishing

●● Comments: New children’s book for spring release
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14Track progress: 
Detailed 
techniques

In this chapter
■■ Update a baseline

■■ Track actual and remaining 
work for tasks and assignments

■■ Track timephased actual work 
for tasks and assignments

■■ Reschedule incomplete work

Practice files
For this chapter, use the practice 
files from the Project2016SBS\Ch14 
folder. For practice file download 
instructions, see the introduction.

Building, verifying, and communicating a sound plan 
might take much or even most of your time as a project 
manager. However, planning is only the first phase of 
managing your projects. After the planning is completed, 
the implementation of the project starts—carrying out 
the plan that was previously developed. Ideally, projects 
are implemented exactly as planned, but this is seldom 
the case. In general, the more complex the plan and the 
longer its duration, the more opportunity there is for 
variance to appear. Variance is the difference between 
what you intended to happen (as recorded in the plan’s 
baseline) and what actually happened (as recorded by 
your tracking efforts).

Properly tracking actual work and comparing it against 
the original plan enables you to identify variance early 
and adjust the remaining portion of the plan when 
necessary. 

This chapter guides you through procedures related to 
updating a baseline, tracking actual and remaining work 
for tasks and assignments, tracking timephased actual 
work for tasks and assignments, and rescheduling incom-
plete work.
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Update a baseline
In Chapter 8, “Track progress: Basic techniques,” you learned how to save a baseline 
for a plan. Recall that a baseline is a collection of important values in a plan, such as 
the planned start dates, finish dates, and costs of tasks, resources, and assignments. 
When you save (or set) a baseline, Project takes a “snapshot” of the existing values and 
saves it in the plan for future comparison. If you’ve previously saved a baseline, you 
might need to update it before recording actual work.

TIP  If you’re not sure whether a plan already has a saved baseline (or multiple base-
lines), or if you’d like to see when a baseline was saved, here’s what to do: On the Project 

tab, in the Schedule group, click the Set Baseline button, and then click the Set Baseline 
command. In the Set Baseline field of the dialog box, any previously saved baselines in the plan 
will be indicated by the dates they were saved. 

Keep in mind that the purpose of the baseline is to record what you expected the plan 
to look like at one point in time. As time passes, however, you might need to change 
your expectations. After saving an initial baseline plan, you might need to fine-tune 
the plan by adding or removing tasks or assignments or making other adjustments. 
To keep an accurate baseline for later comparison, you have several options:

■■ Update the baseline for the entire project  This simply replaces the original 
baseline values with the currently scheduled values.

■■ Update the baseline for selected tasks  This does not affect the baseline values 
for other task or resource baseline values in the plan.

■■ Save a second or subsequent baseline  You can save up to 11 baselines in a 
single plan. The first one is called Baseline, and the rest are Baseline 1 through 
Baseline 10.
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A great view for comparing a baseline with the plan as it is currently scheduled is the 
Tracking Gantt view. 

The Tracking Gantt view shows how tasks in the plan as it is currently scheduled compare to its baseline 
schedule

In the chart portion of this view, the tasks as they are currently scheduled appear as 
blue bars (if they are not critical tasks) or red bars (if they are critical tasks). Below 
them, the baseline values of each task appear as gray bars.

TIP  In Gantt chart views such as the Tracking Gantt view, the colors, patterns, and 
shapes of the bars on the right side of the view represent specific things. To see what any 

item represents, just point to it and a description will appear in a ScreenTip. To see a complete 
legend of Gantt chart items and their formatting, on the Format tab, in the Bar Styles group, 
click Format, and then click Bar Styles.
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Save interim plans
After you start tracking actual values or any time you adjust your plan, you 
might want to take another snapshot of the current start and finish dates. 
You can do this with an interim plan. Like a baseline, an interim plan is a set of 
current values from the plan that Project saves with the file. Unlike the base-
line, however, an interim plan saves only the start and finish dates of tasks, not 
resource or assignment values. You can save up to 10 different sets of interim 
dates in a plan. (If you find that you need multiple snapshots of scheduled 
values in addition to start and finish dates, you should instead save additional 
baselines.)

Depending on the scope and duration of your projects, you might want to 
save an interim plan at any of the following junctures:

■■ At the conclusion of a major phase of work

■■ At preset time intervals, such as weekly or monthly

■■ Just before or after entering a large number of actual values

To compare a plan as it is currently scheduled with its previously saved baseline

1.	 On the View tab, in the Task Views group, click the Gantt Chart arrow, and then 
click Tracking Gantt.

2.	 If necessary, adjust the zoom level: on the View tab, in the Zoom group, in the 
Timescale box, select the timescale setting you want. Project compares the 
plan with the baseline.

3.	 To compare the plan with another baseline (Baseline 1 through Baseline 10), on 
the Gantt Chart Tools Format tab, in the Bar Styles group, click Baseline, and 
then click the baseline you want to see compared.
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To update a previously saved baseline or add an additional baseline

1.	 On the Project tab, in the Schedule group, click Set Baseline, and then click Set 
Baseline to open the Set Baseline dialog box.

2.	 Do either of the following:

●● To update a previously saved baseline, click Set Baseline, and then select 
the specific baseline you want to update. 

●● To save a new baseline, click Set Baseline, and then select the additional 
baseline you want to save.

3.	 Then do either of the following:

●● To update or add the selected baseline for the plan, under For, click Entire 
Project, and then click OK.

●● To update or add the selected baseline just for the selected tasks, under For, 
click Selected Tasks. When you do this, the options under Roll Up Baselines 
become available. You can control how baseline updates should affect the 
baseline values for summary tasks. For example, you could resave a baseline 
for a subtask and update its related summary task baseline values if you want.

4.	 Click OK.

To remove a baseline

1.	 On the Project tab, in the Schedule group, click the Set Baseline button, and 
then click Clear Baseline.

To save an interim plan

1.	 On the Project tab, in the Schedule group, click the Set Baseline button, and 
then click Set Baseline.

2.	 In the Set Baseline dialog box, select Set Interim Plan.

3.	 In the Copy field, select the date values you want to copy.

4.	 In the Into field, select the date values into which you want to copy the fields 
you selected in the Copy field.

5.	 Click OK.
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Track actual and remaining work for tasks 
and assignments
In Chapter 8, “Track progress: Basic techniques,” you learned how to work with actual 
start, finish, and duration values for individual tasks. For tasks that have resources 
assigned to them, you can enter actual and remaining work values for the task as a 
whole or for specific assignments to that task. To help you understand how Project 
handles the actual values you enter, consider the following:

■■ If a task has a single resource assigned to it, the actual work values you enter for 
the task or assignment apply equally to both the task and the resource assign-
ment. For example, if you record that the assignment has five hours of actual 
work, those values apply to the task and to the assigned resource.

■■ If a task has multiple resources assigned to it, the actual work values you enter for 
the task are distributed among or rolled down to the assignments according to 
their assignment units. This level of detail is appropriate if you aren’t concerned 
about the details at the individual assignment level.

■■ If a task has multiple resources assigned to it, the actual work values you enter for 
one assignment are rolled up to the task. However, the new actual work values 
do not affect the other assignments’ work values on the task. This level of detail is 
appropriate if details at the individual assignment level are important to you.

■■ If the actual work value you enter is greater than the planned work, Project sets 
Remaining Work to zero. If actual work is less than planned work, Project recalcu-
lates Remaining Work accordingly. You can also directly edit the Remaining Work 
value if you want.

A great view for recording actual and remaining work is the Task Usage view with the 
Work table displayed.

The Task Usage view has two parts: a table on the left and timephased data (that is, data organized under a 
timescale) on the right
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As you might recall from Chapter 9, “Fine-tune task scheduling,” the two sides of the 
usage view are split by a vertical divider bar. This view lists resources under the tasks 
to which they’re assigned. This information appears in the table on the left side. On 
the right side are rows organized under a timescale. The rows show you the scheduled 
work values for each task and assigned resource. The Task Usage view color-codes 
the rows on the right side: task rows have a shaded background, and assignment rows 
have a white background.

TIP  In this topic, we focus on the Task Usage view to show the results of entering actual 
work per task or assignment. Other means of recording actual work include the Task 

Form or the Task Details Form with the Work detail displayed in a split view with a Gantt chart, 
Task Usage, or other task-centric view. For a refresher on the Task Form, see Chapter 6, “Assign 
resources to tasks.”

Let’s walk through some examples of entering actual work. We’ll start in the Task 
Usage view with the Work table displayed. 

In this example, task 18 initially has 164 hours of scheduled work, which is evenly split between the two 
assigned resources

The Work table includes the Actual Work and Remaining Work columns. The values in 
the Work column are the task-level and assignment-level totals for scheduled work. 
Note that each task’s work value is the sum of its assignment work values. 

In a usage view, you see work values at two different levels of detail: the total value for 
a task or assignment on the left and the more detailed timephased level on the right. 
These two sets of values are directly related. Consider, for example, a task named 
Original art review, which is task 18 in the plan. The 164 hours of total work for task 18 
is the sum of Hany Morcos’s 82 hours of work on the task plus Jane Dow’s 82 hours.
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In the timephased grid, the scheduled work values per time period are displayed—daily, 
in this example. If you add up the daily work values for a specific task or assignment, the 
total equals the value in the Work column for that task or assignment. 

Let’s look more closely at the results of entering an actual work value. In this example, 
when we enter 92 hours of actual work on task 18, Project distributes the actual work 
among the assigned resources and adjusts their remaining work.

This is what the view looks like after 92 hours of actual work are recorded on task 18

Several important things occurred when we entered the actual work on task 18:

■■ Project applied change highlighting to the updated values in the table.

■■ The amount of actual work we entered was subtracted from the Remaining 
Work column (labeled Remaining in the Work table).

■■ The actual work was distributed to the two assignments on the task, result-
ing in 46 hours of actual work being recorded for Hany Morcos and 46 hours 
for Jane Dow. Likewise, the remaining work values were recalculated for each 
assignment.

■■ The updated actual and remaining work values were rolled up to the Acquisition 
summary task and to the Project summary task.

Now that you’ve seen the effect of recording actual work at the task level, let’s look 
at entering actual work at the assignment level. Again, we’ll focus on task 18. When 
we assigned 92 hours of work to the task, Hany Morcos was assigned 46 hours of that 
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work. Now, after we record actual work of 62 hours for Hany, we see that her actual 
and remaining work values are updated, and those updates also roll up to the task 
and its summary task. (Project highlights the changed values.) However, the actual 
and remaining work values for Jane Dow, the other resource assigned to the task, are 
not affected.

After 62 hours of actual work are recorded on Hany Morcos’s assignment to task 18, Hany’s work values are 
updated, but Jane Dow’s assignment is not affected

TIP  A handy way to quickly record actual work and other progress details per assignment 
is via the Tracking tab of the Assignment Information dialog box. In either the Task Usage 

or Resource Usage view, double-click an assignment. In the dialog box, you can set actual work, 
remaining work, actual start, and other values. This dialog box is available regardless of what 
table is displayed in the usage view.

Tracking a task’s actual work-complete value is more detailed than entering a simple 
percentage-complete value on a task. However, neither method is as detailed as 
entering timephased actual work for tasks or assignments (as you will see in the next 
topic). There’s nothing wrong with tracking actual work at the task or assignment 
level (or simply entering a percentage-complete value, for that matter), if that level 
of detail meets your needs. In fact, whether you see the timephased details or not, 
Project always distributes any percentage-complete or task-level or assignment-level 
actual work value you enter into corresponding timephased values. 
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Enter actual costs manually
When you enter actual work values, Project calculates actual cost values for 
the affected task, its summary task, the resources assigned to the task, and 
the entire plan. By default, Project calculates actual costs and does not allow 
you to enter them directly. In most cases, this is what we recommend and 
what is done with the practice files used in this book. However, if you want to 
enter actual cost values yourself in your own plans, follow these steps.

IMPORTANT  The following procedure is provided for your general informa-
tion; however, do not follow this procedure now if you are completing the 
practice tasks in this book. Doing so will produce results that will not match 
those shown in this book.

1.	 Click the File tab to display the Backstage view, and then click Options 
to open the Project Options dialog box.

2.	 Click the Schedule tab.

3.	 Under the Calculation options for this project label, clear the Actual 
costs are always calculated by Project check box.

4.	 Click OK.

After automatic cost calculation is turned off, you can enter or import task-
level or assignment-level actual costs in the Actual field. This field is avail-
able in several locations, such as the Cost table. You can also enter actual 
cost values daily or at another interval in any timescale view, such as the Task 
Usage or Resource Usage view. To do so, with a usage view displayed, click 
Actual Cost on the Format tab, in the Details group.

To record actual and remaining work per task

1.	 On the View tab, in the Task Views group, click Task Usage to display the Task 
Usage view.

2.	 On the View tab, in the Data group, click Tables, and then click Work to display 
the Work table. 
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3.	 In the Actual column for the task for which you want to record actual work, 
enter an actual work value.

4.	 If you want, enter a new Remaining Work value for the task. 

To record actual and remaining work per assignment

1.	 Display the Task Usage view and the Work table.

2.	 In the Actual column for the assigned resource for which you want to record 
actual work, enter an actual work value.

3.	 If you want, enter a new Remaining Work value for the assignment. 

Track timephased actual work for tasks and 
assignments
In Chapter 8, “Track progress: Basic techniques,” you were introduced to simpler ways 
of tracking actuals in a plan. These include recording the percentage of a task that 
has been completed, in addition to its actual start and finish dates. These methods 
of tracking progress are fine for many projects, but Project 2016 also supports more 
detailed ways of tracking.

This topic introduces techniques to track work per time period, such as actual work 
completed per week or per day. Information distributed over time is commonly 
referred to as being timephased, so tracking work by time period is sometimes 
referred to as tracking timephased actuals. This is the most detailed level of tracking 
progress available in Project.

As with the simpler tracking methods, tracking timephased actuals helps you address 
the most basic questions of managing a project:

■■ Are tasks starting and finishing as planned? If not, what will be the impact on 
the project’s finish date?

■■ Are resources spending more or less time than planned to complete tasks?

■■ Is it taking more or less money than planned to complete tasks?
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Entering timephased actuals requires more work on the project manager’s part and 
might require more work from resources, if they have to inform the project manager 
of their daily or weekly actuals. However, using timephased actuals gives you far more 
detail about the plan’s task and resource status than the other methods used for 
tracking progress. Entering timephased values might be the best approach to take if 
you have a group of tasks or an entire plan that includes the following:

■■ High-risk tasks

■■ Tasks of relatively short duration, for which a variance of even one day could 
put the overall project at risk

■■ Tasks for which you’d like to develop or validate throughput metrics, or rates at 
which a specified quantity of a deliverable can be completed over a specified 
time period, such as Copyedit 3000 words per day

■■ Tasks in which sponsors or other stakeholders have an especially strong interest

■■ Tasks that require hourly billing for labor

When you need to track actual work at the most detailed level possible, use the Work 
table and the timephased grid in the Task Usage or Resource Usage view. 

In the Task Usage view, you can enter timephased actual work at the task or assign-
ment level. In the Resource Usage view, you enter actuals at the assignment level. 
In both views, entering actual work in the left side of the view will cause Project to 
update work values distributed over time in the right side of the view. In this topic, 
we’ll look at the reverse: entering actual work in the timephased side of the view and 
seeing the results per task or assignment on the left side of the view.

The previous topic’s example featured the Task Usage view; in this topic, we’ll begin 
with the Resource Usage view. 
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The Resource Usage view shows assignments per resource

TIP  You can change the details (that is, the fields) shown in the timephased grid in a 
usage view. You can add or remove fields and change the formatting of the fields that 

are shown. For example, you can add the Actual Work field. To see the available fields and 
formatting options, on the Format tab, in the Details group, click Add Details. 

In both views, you can enter actual work values for individual assignments daily, 
weekly, or at whatever time period you want (by adjusting the timescale). For exam-
ple, if a task has three resources assigned to it and you know that two resources 
worked on the task for eight hours one day and the third resource worked for six 
hours, you can enter these as three separate values on a timephased grid.

A key to working effectively in a usage view is setting the timescale correctly. You can 
change the zoom level of the timescale to control the time period in which you enter 
actual values in the timephased grid. For example, you can change the timescale to 
show weeks rather than days; when you enter an actual value at the weekly level, that 
value is distributed over the week.

TIP  Project includes several handy shortcuts for navigating in the timephased grid side 
of the usage views. In the Task Usage view, use the Scroll To Task button on the Task Tab, 

in the Editing group, to display the earliest scheduled work on the selected task or assignment. 
You can also use the Scroll To Task command in the shortcut menu for tasks. In the Resource 
Usage view, use Scroll To Task to see the selected resource’s or assignment’s scheduled work. In 
both views, you can quickly get to a specific date in the grid (or a task or resource ID) by using 
the Go To command via the keyboard shortcut Ctrl+G. If you forget this keyboard shortcut, just 
enter go to in the Tell Me box and Project will show you the command.
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Here’s an example of entering timephased actuals in a usage view. As you saw in the 
previous topic, the scheduled work per task, resource, or assignment is equal on the 
two sides of a usage view. The difference is that the scheduled work is shown as a 
single total value on the left side but distributed over time on the right side. 

We’ll begin in the timephased grid of the Task Usage view with the Work table 
displayed. We’ll record actual work for task 19, Author review of content edit.

Here we’ve entered 8 hours of actual work for Thursday (which is what was scheduled) and 10 hours of 
actual work for Friday (when 16 hours was originally scheduled) on task 19

As you saw in the previous topic, the actual work recorded on the task is distributed 
to its assignments. In the timephased grid, you can see per time period how the actual 
work gets distributed.

TIP  When entering actual work, you do not need to include the “h” abbreviation (to 
denote hours). You can simply enter the number and Project will record it as hours. 

Hours is the default work value for data entry. If you want, you can change this. Click the File tab 
to display the Backstage view, and then click Options. On the Schedule page of the Project 
Options dialog box, in the Work Is Entered In box, select the default time increment you want.

Next we’ll enter actual work on the assignment in the timephased grid.
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Here we’ve entered 6 hours of actual work for the Copyeditors and 8 hours for Tad Orman for Monday on 
the same task

In this example, the actual work values entered for the assignments differed from 
the scheduled work. Project accounted for the difference by adjusting the scheduled 
work at the end of the assignments.

Project adjusted the scheduled work to account for the actual work values that were recorded that varied 
from scheduled work

When you record actual work in the table on the left side of the view, Project records 
the actual work to match scheduled work in the timephased grid on the right side of 
the usage view. The main advantage of entering actual work in the timephased grid 
instead of in the table on the left side of the view is that you can precisely control the 
dates for which the actual work gets recorded. 
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Project management focus: Collect actuals 
from resources
The Resource Usage view is similar to a timecard. In fact, to enter assignment-
level actual work values, you might need some form of paper timecard or its 
electronic equivalent. Several methods are used to collect such data from 
resources, assuming that you need to track actual and remaining work at this 
level of detail. Some collection methods include the following:

■■ Collect actual values yourself  This method is feasible if you commu-
nicate with only a small group of resources on a frequent basis, such as 
a weekly status meeting. It’s also a good opportunity to talk directly to 
the resources about any blocking issues or surprises they might have 
encountered (either positive or negative) while performing the work.

■■ Collect actuals through a formal status reporting system  This 
technique might work through the already-existing hierarchy of your 
organization and serve additional purposes besides project status 
reporting.

Regardless of the data collection methods you use, be aware that resources 
might have some concern about how their actual work values reflect their over-
all performance. You might need to communicate to resources that schedule 
actuals help in managing the project, but performance evaluation is a business 
management focus, not a project management focus.

If your organization uses a timecard reporting system, you might be able 
to utilize this timecard data in Project as timephased actuals. You might not 
need to track at this level, but if resources complete timesheets for other pur-
poses (billing other departments within the organization, for example), you 
can use their data and save yourself some work.

Speaking of timecards, depending on how your organization operates, 
you might want to explore Project Professional and its interoperability with 
Microsoft SharePoint and Project Web App (PWA). For more information, see 
Appendix C,” Collaborate: Project, SharePoint, and PWA.”
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TIP  Task and assignment values are directly related; an update to one directly affects 
the other. However, you can break this relationship if you want. Doing so enables you to 

record progress for resource assignments, for example, and manually enter actual values for 
the tasks to which those resources are assigned. You normally should not break this relationship 
unless you have special reporting needs within your organization—for example, when you 
must follow a status reporting methodology based on something other than the actual values 
recorded for assignments in plans. To break this relationship, do the following: Click the File tab 
to display the Backstage view, and click Options. In the Project Options dialog box, on the 
Schedule tab, under the Calculation Options For This Project label, clear the Updating Task 
Status Updates Resource Status check box. This setting applies to the entire plan you have open 
at the time; you cannot apply it only to some tasks within a plan. 

To record timephased actual work in the Task Usage view

1.	 On the View tab, in the Task Views group, click Task Usage to display the Task 
Usage view.

2.	 On the Task Usage Tools Format tab, in the Details group, click Actual Work. 
The Actual Work detail row appears in the timephased portion of the view. 

3.	 If needed, adjust the timescale to match the time interval at which you want to 
enter actual work (for example, daily or weekly): On the View tab, in the Zoom 
group, click the Timescale arrow, and then click the timescale time unit you want.

4.	 In the timephased grid, at the intersection of the task or assignment and the 
date you want, enter an actual work value.

To record timephased actual work in the Resource Usage view

1.	 Display the Resource Usage view and Actual Work detail, and adjust the timescale 
as needed.

2.	 In the timephased grid, at the intersection of an assignment and the date you 
want, enter an actual work value.
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Reschedule incomplete work
During the course of a project, work might occasionally be interrupted for a specific 
task or for the entire project. If this happens, you can have Project reschedule the 
remaining work to restart after the date you specify.

When you reschedule incomplete work, you specify the date after which work can 
resume—the rescheduled date. You reschedule incomplete work in the Update Project 
dialog box.

Use the Update Project dialog box to reschedule incomplete work

Here is how Project handles tasks in relation to the rescheduled date:

■■ If the task does not have any actual work recorded for it prior to the rescheduled 
date and does not have a constraint applied, the entire task is rescheduled to 
begin after that date.

■■ If the task has some actual work recorded prior to the rescheduled date but none 
after it, the task is split so that all remaining work starts after the rescheduled 
date. The actual work is not affected.

■■ If the task has some actual work recorded for it prior to, and after, the resched-
uled date, the task is not affected.
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To reschedule incomplete work

1.	 To reschedule work just for specific tasks, select those tasks first.

2.	 On the Project tab, in the Status group, click Update Project to open the 
Update Project dialog box.

3.	 Select Reschedule uncompleted work to start after, and in the date box, enter 
or select the date you want.

4.	 Do one of the following:

●● Click Selected Tasks to reschedule work just for the selected tasks.

●● Click Entire Project to reschedule work for the entire project.

5.	 Click OK.

Skills review 
In this chapter, you learned how to:

■■ Update a baseline

■■ Track actual and remaining work for tasks and assignments

■■ Track timephased actual work for tasks and assignments

■■ Reschedule incomplete work
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Practice tasks
The practice files for these tasks are located in the Project2016SBS\Ch14 
folder.  

IMPORTANT  If you are running Project Professional with Project Web App/Project 
Server, take care not to save any of the practice files you work with in this book to 

Project Web App (PWA). For more information, see Appendix C, “Collaborate: Project, 
SharePoint, and PWA.”

Update a baseline
The scenario: At Lucerne Publishing, the planning for the new children’s book project 
has undergone some additional fine-tuning, including adjustments to task durations 
and the addition of a task. Because of these changes, you need to capture a new 
baseline before work begins. Open the UpdateBaseline plan in Project, and perform 
the following tasks:

1.	 Examine the current baseline in the Tracking Gantt view with the timescale set 
to weekly.

In the Tracking Gantt view, note that the recently added task 18 lacks a baseline

2.	 Update the baseline for the entire plan.
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After the plan’s baseline is updated, the baseline dates align with the as-scheduled task dates and 
task 18 now has a baseline

Track actual and remaining work for tasks and assignments
The scenario: Several tasks in the plan have more than one resource assigned. You’d 
like to get a better look at how your recording of actual work on such tasks affects 
assigned work. Open the TrackWork plan in Project, and perform the following tasks:

1.	 Display the Work table in the Task Usage view.

2.	 Record 92 hours of actual work on task 18, Original art review.

After entering actual work on task 18, note how the actual work is split between the two assigned 
resources
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3.	 On the same task, change Hany Morcos’s 46 hours of actual work to 62 hours.

After entering actual work on an assignment to task 18, note that the other assignment to the same 
task is not affected

Track timephased actual work for tasks and assignments
The scenario: The Acquisition phase of work has been completed, and the Editorial 
phase has begun. Because of the larger number of resources involved and the vari-
ability of the editorial work, these tasks are the riskiest ones so far in the project. To 
manage the actuals of these tasks in the most detailed way possible, you will record 
timephased actuals. Open the TrackTimephasedWork plan in Project, and perform 
the following tasks:

1.	 Scroll the timephased grid in the Task Usage view until the scheduled work for 
task 22, Organize manuscript for copyedit, is visible.

2.	 Show the Actual Work detail in the timephased grid of the view.

3.	 Record 9 hours of actual work on task 22 for Wednesday, May 30, and 15 hours 
for Thursday, May 31.
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After entering task-level timephased actual work, note the updates to the two assignments on the task 

4.	 Adjust the timescale to weekly.

5.	 Record 12 hours of actual work for Dan Jump’s assignment to task 22, Organize 
manuscript, for the week of June 3.

After actual work is recorded on one assignment to task 22, the blue change highlighting shows you 
the task-level and summary task-level changes to actual work
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Reschedule incomplete work
The scenario: Editorial work has been completed. The team has started work on the 
next phase. However, you need to troubleshoot a delay in work caused by an unfore-
seen problem. Open the RescheduleIncompleteWork plan in Project, and perform the 
following tasks:

1.	 Scroll the Task Usage view to display the latest actual work recorded for task 31, 
Proofread and index.

2.	 Reschedule incomplete work for the entire project to start after August 7, 2018.

Note the absence of scheduled work for task 31 (as indicated by 0h) on Monday and Tuesday due to 
the rescheduled incomplete work; in a Gantt chart view, this would appear as a split task
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Index
Numbers and Symbols
8/80 rule, definition  527
* (asterisk) in task bar names  375

A
Account page (Backstage view)  20
accrual

definition  527
methods  217–218

accruing fixed costs  217
actions indicators  109
active view  14
activities  47
actual costs  279
actuals  157

changing default work values  338
definition  527
entering manually  334
entering task values  168–169
recording per task  334
recording tasks in Tracking table  171
recording tasks in Update Tasks dialog 

box  171
timephased  335–339
tracking  158–159, 335–339

Advance proofs  247
ALAP (As Late As Possible) constraints  188–189
allocations, defined  527 

See also resource allocations
As Late As Possible (ALAP) constraints  188–189
As Soon As Possible (ASAP) constraints  187–189
ASAP (As Soon As Possible) constraints  187–189
assigning resources to tasks  102–104
assignment calculation  201
assignment notes  67
assignment units  102 

See also units

assignment units values  201–202
assignment values, breaking relationship to 

task values  341
assignments  101

adjusting in Team Planner view  252–255
applying predefined contours  245
applying work contours  243
changing cost rate tables  239
changing default start times  243
cost values  104
definition  527
delaying start  242–243
editing details  107
editing work per time period  246
recording work  335
and resource costs  357
tracking work  330–335
tracking timephased actual work  335–339
unit values  102
viewing  103–104, 107

asterisks (*) in task bar names  375
AutoFilter  302, 527
automatically scheduled tasks, definition  527
automating tasks  428

B
Backstage view  19–20, 527
bar charts, on Gantt charts  128
bars  See task bars
bar styles

changing in Calendar view  392
changing in Gantt chart view  374

base calendars  39–40
applying to tasks  197–198
creating new  197
definition  527
for sharer plans  479

baseline costs  279
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baseline plans  159
comparing  160
previously saved, finding  326

baselines
adding additional  329
clearing previously saved  162
comparing with plans  327
definition  527
displaying Gantt bars in Gantt chart 

view  162
identifying variances  355
multiple  160
previously saved, updating  329
removing  329
saving  159–162
switching in Gantt charts  378
updating  326
values  160

best practices, capturing  518
blank reports  407
book content errors, reporting  xviii
bottom-up planning  57, 528
box styles  386–388
boxes

formatting in Network Diagram view  388
styles  386–388

Budget Cost visual report  360–361, 362
built-in filters

highlight filters  308
regular filters  304
using  307

built-in groups  298–299
built-in tables  311
built-in views  315
burdened rates  86
Burndown report  352

C
calculated costs  358
calculating work  102
calendars 

See also project calendars; resource 
calendars

base  39–40

base, applying  197–198
base, creating  197
choosing current date  39
copying to/from global template  424–427
custom work week  42–43
custom working times  41–43
definition  528
nonworking dates  42
nonworking times  42
task  196

Calendar view
changing appearance of items  391
changing bar styles  392
changing week height  392
definition  528

callouts, switching from task bars in 
Timeline view  136

Cash Flow report  360, 362
cells

formatting  130, 133
removing formatting  134

certification, Project-related  504
chart elements, including  412
chart format, changing  414
chart layout, changing  412
chart style, changing  412, 414
charts

adding/removing data  412
adding to reports  410
changing format  414
changing layout  412
changing style  412, 414
Field List pane  413–414
including chart elements  412
including data labels  412
selecting information to include  414

classroom training, integrating this 
book  521–524

colors
applying to predecessors  180
applying to successors  180, 182

columns
adding to tables  312
pasting text as  448

538

baseline plans



combination view  14, 23
comma-delimited text files, exporting 

project data to  454
commands  14

for specific elements  16
split buttons  18

commands (Quick Access Toolbar)
adding  434, 436
removing  436

commands (ribbon), modifying  437
communities

project management  505
Project users  503
questions and answers  504

Comparison reports  407
completing tasks  165–166
completion percentages, entering  165–166
consolidated plans  480–483

benefits  480
creating  482
definition  528
displaying summary tasks  483

consolidated projects  See consolidated 
plans

constraint balance  498–501
constraints

As Late As Possible (ALAP)  189
As Soon As Possible (ASAP)  187
categories  187
vs. deadlines  214
definition  528
Finish No Earlier Than  192
flexible  187–189
hard  187
inflexible  187–189
moderate  187
of projects  495–497
scheduling tasks  186, 189–191
semi-flexible  187–188
soft  187
start/end dates  192
Start No Earlier Than  192
using  191, 192
viewing details  187

content errors, reporting  xviii

context menus  15
contouring, definition  528
contours

applying to assignments  243–245
definition  528
and fixed-duration tasks  244

copying
elements between plans  424–426
Timeline views  143–144
views  141–142

copying reports  141
to the Clipboard  144
to/from global template  424

corrections to book content  xviii
cost constraints  496
Cost Overview report  352
cost per resource  116, 118
cost per task  116, 118
cost per use  85
cost rate tables  237–239, 528
cost rates  241
cost reporting  350–352
cost resources

adding  92
assigning to tasks  114
common types  91
definition  528
resource pools  470
setting up  91–92
and tasks  91

Cost table  358, 363 
See also tables
in Resource Sheet view  365
in Resource Usage view  366
in Task Sheet view  282, 362
in Task Usage view  361

cost values  104
cost variance analysis  351–352
cost variances  357–361
costs

calculated  358
comparing  280–282
definition  528
displaying details in Resource Usage 

view  366
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costs (continued)
distributed over time, displaying  282
scheduled  358
types of  279
viewing  280–283

Costs report, viewing  282
critical paths  222–224, 282, 528
critical tasks  282
cross-plan links  486–487 

See also dependencies
changing relationship types  487
creating  486
deleting  487
between inserted plans  486

cross-project links  See cross-plan links
current costs  279
custom calendars

sharing between plans  425–426
storage location  424

custom fields  310
copying between plans  424–426
copying to/from global template  424–427

custom filters  304, 306–307
custom groups  299–301
custom highlight filters  308
custom reports  406–408, 410
custom tables  311–312
custom views  315–317
customizations

using the global template  424–427
resetting to defaults  438

customized plan elements
copying between plans  424–426
options for copying to global template  427
replacing  426
storage location  424

customized ribbon, sharing with other 
Project users  435

D
Dashboard report  354
dashboard reports  351

data
copying to other programs  446–449
exporting  454–457
exporting to other file formats  353, 458
pasting from other programs  449
selecting  448
supported file types for exporting  455

data categories, adding to/removing from 
charts  412

data maps  450 
See also export maps; import maps
built-in  456
defining in the Export Wizard  456–457

data series, adding to/removing from 
charts  412

data templates
creating or modifying  389
defining  387

data visualizations  458–461
date ranges

changing for timeline bars  384
changing resource availability  234–236

dates
choosing current  39
deadlines  214–216
setting nonworking  42

deactivating tasks  283–284
deadline indicators, changing 

appearance  374
deadlines  214–216

vs. constraints  214
definition  528

dedicated resource pools  474
delimited text files, exporting project data 

to  454
deliverables, definition  528
dependencies 

See also cross-plan links
between plans  483–487
definition  529

Design tool tab (ribbon)  17
destination programs, definition  529
display settings, adapting procedures 

for  xvi
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document properties  43
downloading practice files  xiv
drawing on Gantt charts  131
drawing precedence of Gantt bars  381
driving predecessors  529
durations

definition  529
summary tasks  225–226
in work calculations  102

E
ebook edition of this book  xv
editing

custom groups  299–301
filters  306–307
tables  311
views  315–317

effort-driven scheduling  107–111
best practices  112
definition  529
and task types  203

elapsed duration, definition  529
elements, copying to/from global 

template  424–427
email messages, attaching plans  20
enterprise project management (EPM)  518
Entry table, definition  529
EPM (enterprise project management)  518
equipment resources  82
errata for this book  xviii
errors in this book, reporting  xviii
evaluating project status  170
Excel

opening workbooks in Project  453
pasting data from Project  446
reports  360

Excel charts, exporting data as  459
Excel PivotCharts  460
Excel PivotTables  460
Excel visual reports  460
Excel workbooks, exporting project data 

to  454
export maps 

See also data maps; import maps
copying between plans  424–426

copying to/from global template  424–427
definition  529

Export page (Backstage view)  20
Export Wizard  456–457
exporting data

as Excel charts  459
to other file formats  353, 458
supported file types  455
as Visio diagrams  459

external file formats, changing setting for 
opening  454

external predecessors
identifying  487
visual indication  484

external successors
identifying  487
visual indication  484

external tasks  484–487

F
feedback information  xviii
Field List pane

for charts  413–414
displaying plan values  408
organizing plan values  408
for tables  415–417

fields
changing appearance in nodes  387
copying between plans  424–426
copying to/from global template  424–427
custom, creating  310
definition  529
displaying in reports  408
filtering in charts  414
filtering in reports  408
filtering in tables  417
grouping in reports  408
grouping in tables  417
including in charts  414
including in tables  417
mapping for export  456–457
outlining in reports  408
reordering in charts  414
sorting in reports  408
sorting in tables  417
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file formats
changing settings  454
for saving project plans  454

file types supported for data export  455
files

opening external program files in 
Project  453

for practice tasks  xiv
setting options  39

filtering
built-in filters, applying  302
definition  529
fields in reports  408
highlighting results  305
resources  305, 307
tasks  305, 307

filters  302–308
AutoFilter  302–303
copying to/from global template  424–427
highlight  308
Slipping Tasks  355

finish dates  281–282
Finish No Earlier Than (FNET) 

constraints  188, 192
Finish No Later Than (FNLT) constraints  188
finish-to-finish relationships  60, 183
finish-to-start relationships  59–60, 183–184
fixed consumption rates

assigning to material resources  248
definition  529

fixed costs  216–218, 357
accrual methods  218
definition  529

fixed duration
definition  529
task types  199

fixed units
definition  529
task type  199

fixed work
definition  530
task type  199

flexible constraints  187–193, 530
float  See slack
footers  395
formatting

cells  133, 134
charts in reports  140
Gantt bars  130, 132
Gantt bar shapes  132
Gantt charts  129–130
predecessors  182
successors  182
tables in reports  140
Task Path  182
tasks  69

Format tool tab (ribbon)  17
formulas, calculating work  102
free slack  222, 530
fully allocated

definition  530
work resources  266

functional manager  531

G
Gantt bar styles  374–381

changing  374
creating  379
excluding task types  379
modifying text  380
reordering  381

Gantt bars  129
applying color to predecessors  180
applying color to successors  180, 182
applying Gantt chart styles  132
baseline, displaying in Gantt chart view  162
changing appearance  374, 377
displaying details  378
extending progess on  167
formatting  130
formatting shapes  132
removing formatting  132
reordering  375
setting progess on  167
summary tasks  225
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Gantt chart bars  See Gantt bars
Gantt Chart view  23, 103

baseline Gantt bars  161
definition  530
including in macros  441
nonworking time  166
previewing  145
printing  145

Gantt chart views  128–134, 374
adding bars  375–377
critical paths  223
displaying baseline Gantt bars  162
elements of  128
formatting elements  378
free slack  223
panning from Timeline view  138
project summary tasks  66
switching baselines  378
task relationships  61
zooming from Timeline view  138

Gantt charts
bar chart elements  128
changing timescales  138
drawing on  131
formatting chart elements  129–130
linking objects  131
link lines  129
scrolling  138
style groups  129
styles  129–130
summary tasks  129
tasks  129

Gantt with Timeline view  23
getting help  xviii
giving feedback  xviii
global template  424–427

definition  530
options for adding new elements  427

graphics, pasting from other programs  449
Group field, definition  530
grouping  296–298

clearing  301
fields in reports  408
resources  298, 301

tasks  298, 301
in views  298

groups  14
built-in  298
copying to/from global template  424–427
creating on ribbon tabs  437
custom, creating and editing  299
definition  530
viewing  298

H
hard constraints  187
hard finish dates  281
hardware support  xviii
headers  395
Help resources

Office  504
Project  504
project portfolio management (PPM)  520
Project Web App (PWA)  518
SharePoint  512
this book  xviii
Visual Basic Editor  432

highlight filters  305, 308
highlighting

applying  305
clearing  308

hyperlinks
adding to tasks  68
definition  530
removing from tasks  69

I
ID numbers  48
images

adding to reports  411
pasting from other programs  449

import maps 
See also data maps; export maps
copying between plans  424–426
copying to/from global 

template  424–427
definition  530

Import Wizard  450–452
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inactivating tasks  283–284
incomplete work, rescheduling  342–343
inflexible constraints  187–193, 530

Must Finish On (MFO)  188, 191
Must Start On (MSO)  188, 191–192

Info page (Backstage view)  19
inserted plans  480–483

creating cross-plan links  486
definition  530
displaying details  483
task numbering  481

interim plans
definition  530
saving  328–329

L
lag time

adding to linked tasks  184–186
definition  530

Late Tasks report  355, 357
Layout tool tab (ribbon)  17
lead time

adding to linked tasks  184–186
definition  531

legacy file format settings, changing  454
legends, customizing and printing  394
leveling

overallocated resources  273–280
setting level resources  278
setting options  278

leveling delays  271–272, 279
Leveling Gantt view  279
line managers, definition  531
lines, formatting in Gantt charts  378
link lines

as elements on Gantt charts  129
formatting in Gantt charts  378

linking tasks  59–64, 183–186
links

definition  531
identifying in a plan  487

logging bugs  xviii

M
macros

copying between plans  424–426
copying to/from global template  424–427
definition  531
deleting  430
editing  431–433
keyboard shortcuts  429
naming conventions  429
recording  427–430
running  429–430
storage location  428
using in other plans  428

manually scheduled tasks, definition  531
mapping fields for export  456–457
maps

copying between plans  424–426
copying to/from global template  424–427

master projects  See consolidated plans
material labels  247
material resources  79, 247–249, 531
maximum capacity  82–83
maximum units

definition  531
value  82–83, 234

Microsoft Press contact information  xviii
Microsoft SharePoint, using Project 

with  507–512
milestones

definition  531
formatting dates  382
indicators  132
tasks  55

mistakes, informing Microsoft Press  xviii
moderate constraints  187
modules

copying between plans  424–426
copying to/from global 

template  424–427
Must Finish On (MFO) constraints  188
Must Start On constraints  192
Must Start On (MSO) constraints  188
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N
naming conventions for resource pools  473
negative slack  192, 531
Network Diagram nodes, data templates  389
network diagrams  385–387
Network Diagram view  385–387

definition  531
formatting boxes  388
formatting options  386
modifying nodes  389
showing and hiding relationships  388
task relationships  61

new elements, storage location  424
New page (Backstage view)  19
Night Shift base calendar  40, 531
nodes  385–387

changing appearance  386
modifying in Network Diagram view  389

noncritical paths, displaying slack  224
noncritical tasks, definition  531
nonworking dates, setting  42
nonworking times

displaying  166
setting recurring  42

Notepad, pasting text from Project  447
notes

definition  531
project summary tasks  68
types  67

O
Office Help resources  504
OLAP (Online Analytical Processing) cubes  459
ongoing operations, definition  531
Online Analytical Processing (OLAP) cubes  459
organizational benefits of PPM  518
organizations, project management 

information  518
organizations, resource workload and 

availability  518
Organizer  425–427

accessing  19
definition  532
structure  425

outlines
creating  56–58
definition  532
project summary tasks  56

outlining fields in reports  408
overallocations

definition  532
finding in Resource Allocation 

view  269–270
resolving manually  270–272
work resources  266

P
page footers  395
page headers  395
page layout options for views  393
page setup options for views  393–394
pan and zoom control  138
panning Gantt chart views from Timeline 

views  138
pay rates 

See also resources; work resources
accruing costs  85
adding automatically  85
burdened rates  86
changing over date ranges  239–240
cost per use  85
cost rate tables  237–239
effective date  240–241
entering  84–86, 240–241
entering resource standards  85
formats  84, 240–241
managing cost  84–86
for multiple resources  237–240
overtime  85–86
set fees  85

PDF files, exporting plan views as  396
Peak values  201
percentages, completion  165–166
phases

bottom-up planning  57
definition  532
top-down planning  57
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pinning plans to Recent Projects list  20
pinning templates to New page (Backstage 

view)  20
plan baselines

saving  159–161
updating  326–327

plan costs  279–283 
See also plans, sharer plans
fixed costs  216–218
resource costs  118, 363–365
task costs  118

plan elements, copying  424–427
plan status, reporting  28–30
plan values, displaying  408
planned costs  114
planning

bottom-up  57
definition  532
top-down  57

plans 
See also plan costs; sharer plans
attaching to email messages  20
checking durations  66
checking status  28–31
comparing to baselines  328
consolidated  480–483
creating  12–13, 19, 21–22, 38
critical paths  222–224
default scheduling mode  65
defined  4, 532
dependencies between  483–487
entering properties  44
entering titles  43–44
filtering details  302–308
finish dates  65, 279–283
grouping details  296–301
inserted  480–483
key indicators  115
linking to resource pools  471, 477
links between  See cross-plan links
opening  12, 22
outlining with summary tasks  56–58
pinning to Recent Projects list  20
printing  20

saving  22, 39, 328
sharing customized elements  19
sorting details  292–294
start dates  39
statistics  66–67
switching between manual/automatic 

scheduling  64
top-down focus  226
tracking as scheduled  163–165
unlinking from resource pools  478
updating with actual values  168–169
viewing properties  43

PMBOK  493
PPM (project portfolio 

management)  518–520
benefits of  518
definition  532
deployment training  520
Help resources  520

practice files for this book  xiv
practice tasks  10

files for  xiv
timing  524

predecessor tasks  59–63, 180–182
applying color to  180
for cross-plan links  484–487
definition  532
external  484
identifying in a plan  487
task chains  181

print options
modifying  395
for views  393, 395

Print page (Backstage view)  20
print preview

multipage  145
for views  393

printing
plans  20
reports and views  144–146
restrictions  146

procedures, adapting to your display  xvi
product scope  49, 497, 532
product specifications  497
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progress, tracking  158–159, 325
progress bars, definition  532
Project

development team blog  504
Help resources  504
previous versions  457
product website  504
training and certification  504
user groups  503–504

Project 2016
accessing  5
new features  6
vs. previous versions  6–8
setting options  19–20
software support  xviii
user interface  12–18
version information  20
views  14–15

project at a glance  141
project calendars  39 

See also calendars; resource calendars
custom work weeks  42–43
default  40
definition  532
nonworking dates  42
nonworking times  42
selecting  42

project constraints
managing  498–501
in the project triangle  495–497

project costs  360
Project desktop program editions  5
project management

analyzing project performance  350–352
bottom-up planning  57
collecting actuals from resources  340
communicating status  349
estimating task durations  52
evaluating resource allocation  268
finish date and critical tasks  282
teaching  525
top-down planning  57

Project Management Institute (PMI)  505

Project Management Professional 
(PMP)  505

project-management tools  501
Project Online  5

online resources  520
supporting Project Web App (PWA)  518

Project Overview report  351
Project partners  520
project plans

exporting data  458
including information in charts  414
including information in tables  417
opening with multiple versions of 

Project  457
project portfolio management (PPM)  518–520

benefits of  518
definition  532
deployment training  520
Help resources  520

Project Professional  5
project scope  49, 497, 532
Project Server  5

online resources  520
supporting Project Web App (PWA)  518

Project Standard  5
Project Statistics dialog box, opening  354
project summary tasks  56, 66–67

of consolidated plans  483
cost values  358–359
definition  532

Project tab (ribbon)  17
project triangle  495, 532
Project Web App (PWA)  5

definition  532
Help resources  518
using Project with  513–518
supporting technologies  518

projects
attributes of  494
costs, types of  279
defined  9
definining  494
definition  532

547

projects



projects (continued)
evaluating status  170
managing constraints  498–501
PMBOK definition  493

properties
changing  39
entering  44
viewing  43

prorated fixed costs  217
PWA (Project Web App)  5

definition  532
Help resources  518
supporting technologies  518
using Project with  513

Q
Quick Access Toolbar  13

customizing  433–434
resetting to defaults  437

R
read-only resource pools

opening  475
updating  478

recording actuals  169
recording macros  427–430
recording work as scheduled

through a specific date  164
through the current date  165
through the status date  165

recurring tasks  218–222, 533
relationships  533 

See also task relationships
remaining costs  279
renumbering resources and tasks  294
reordering Gantt bar styles  381
repetitive activities, recording as 

macros  427–430
report label  14
Report tab (ribbon)  17
reports  28–30

Budget Cost  360–362
Burndown  352
Cash Flow  360, 362

adding charts  410
copying  See copying reports
cost-centric  352
Cost Overview  352
creating custom  406–408, 410
customizing  139–140
Dashboard  354
definition  533
displaying  31, 140
displaying with views  31
filtering fields  408
grouping fields  408
adding images  411
Late Tasks  355, 357
outlining fields  408
page setup options  146–147
printing  144–146
Project Overview  351
project status  350–353
Resource Cost Overview  365–366
adding shapes  411
sharing  141
Slipping Tasks  355–357
sorting fields  408
applying styles to tables and charts  140–141
adding tables  410
Task Cost Overview  359, 362
adding text boxes  410–411
vs. views  409
visual  360

rescheduling incomplete work  342–343
resetting to defaults

Quick Access Toolbar  437
ribbon  438

Resource Allocation view  267
resource allocations

editing  271–273
evaluating  268
examining over time  266–270
finding overallocations  269–270
resolving overallocations manually  270–272

resource assignments  101
adding/removing  107–111
grouping by task  118
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resource availability  518
resource calendars  87–88 

See also calendars; project calendars
applying to multiple resources  91
assigning different base calendars  91
definition  533
exceptions  87–88
managing multiple  88
modifying defaults  89–90
Standard base calendars  87

resource capacity, viewing  250–252
resource-centric views  314
Resource Cost Overview report  365–366
resource costs

derivation  357
examining  362–365
sorting  363
variances  364

resource fields  See fields
Resource Forms  476–477
Resource Graph view  251
resource groups  294–295
resource leveling  273–276, 533
resource managers, definition  533
resource overallocations

adding leveling delays  272
editing assignment-level work  272
finding  269–270
leveling  273–279
resolving manually  270–272

resource pools
allocation details  476
base calendars  479
changing working times  479
for consolidated plans  482
dedicated  474
definition  470, 533
managing links to sharer plans  477–478
naming conventions  473
opening options  475
synchronizing with sharer plans  476–477
updating read-only pools  478
viewing resource usage details  478

Resource tab  17

Resource Usage view  25
in combination with Resource Form  476
pane content  251, 268–269
recording timephased actuals  341

resource workload  518
resources 

See also pay rates; work resources
assigning to multiple plans  473
assigning to recurring tasks  221
assigning to tasks  102–106
changing availability over date 

ranges  234–236
checking plan costs  118
cost  79, 91–92
cost rate tables  238
cost values  104
cost variances  364
customizing availability  235–236
definition  533
equipment  82
filtering/clearing filters  305, 307, 308
grouping/ungrouping  298, 301
highlighting using filters  308
importing from address books  81
leveling constantly  276
material  79
maximum capacity  250
maximum units value  234
notes  92–94
project management  503–505
renumbering  294
sorting  292, 294–295
sorting by cost amounts  365
sorting by cost variances  364
types  79
viewing  25–26
viewing costs  116
work  79–86

ribbon  14
collapsing/expanding  17
commands  17
customizing  433, 435, 437
resetting to defaults  438
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ribbon (continued)
sharing customizations with other Project 

users  435
tabs  16–18

ribbon interface, definition  533
ribbon tabs  16–18 

See also individual tab names
customizing content  437
resetting to defaults  438

right-click menus  15
risks, definition  533

S
saving

interim plans  328
and naming plans  22
project plans  39

schedule variance  354–356
scheduled costs  279, 358
schedules, sharing  141
scheduling

assigning additional task 
resources  112–113

automatic  107
effort-driven  107–111, 203
removing task resources  113
split tasks  195
summary tasks  226

scheduling formulas, definition  533
scheduling tasks

automatically  48, 51
calculating durations  54
constraints  189–190
elapsed durations  54
manually  48, 51
predecessor/successor relationships  61
spanning working/nonworking times  54
split  195
summaries  56
switching between manual/

automatic  63, 64
using contraints  186–193
using task types  199–202
viewing details using Task Inspector  204

scope
constraints  497
creep  500
definition  534

ScreenTips  14
security settings

checking  430
effect on macros  430
for file formats  452
for opening and saving files  452

semi-flexible constraints  187–193
definition  534
Finish No Earlier Than (FNET)  188
Finish No Later Than (FNLT)  188
Start No Earlier Than (SNET)  188, 190, 192
Start No Later Than (SNLT)  188, 190

sequences  59, 534
shapes

adding to reports  411
Gantt bars, formatting  132

Share page (Backstage view)  20
shared resources, viewing usage  478
SharePoint

Help resources  512
using Project with  507–512
synchronization options  20
synchronizing project tasks  511
tracking project tasks  510

sharer plans  471 
See also plan costs; plans
base calendars  479
benefits  471
definition  534
effect of deleting  479
linking to resource pools  471, 477
managing resource pool links  478
synchronizing with resource pools  477
unlinking from resource pools  478–479
updating with resource pool 

changes  476
updating working times in resource 

pool  479
sharing elements between plans  424–426
sheet views  25
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shortcut menus  15, 534
slack

changing threshold  224
definition  534
displaying for noncritical tasks  224
types of  222

slipped tasks, identifying  354–356
Slipping Tasks filter  355
Slipping Tasks report  355–357
soft constraints  187
soft finish date  281
software support  xviii
Sort By dialog box  294
sort order  293–294
sorting

definition  534
fields in reports  408
using multiple criteria  295
renumbering lists  294
resetting order  296
resources  292, 294–296
tasks  295–296

source programs, definition  534
split buttons  18
split tasks

definition  534
rejoining  195
rescheduling second segment  195

splitting tasks  194–195
split views  14, 23

displaying  27
Task Form with Gantt chart  26

sponsors, definition  534
stakeholders, definition  534
Standard base calendar  40

definition  534
for resource calendars  87

Start No Earlier Than (SNET) 
constraints  188, 190, 192

Start No Later Than (SNLT) constraints  188, 190
Start screen  12
start-to-finish relationships  60, 183
start-to-start relationships  60, 183
status bar  15

status date, definition  534
styles

applying to charts in reports  140
applying to Gantt bars  132
applying to tables in reports  141
for presentations  129
for scheduled tasks  129
Gantt charts  129–130

subprojects  See inserted plans
subtasks, definition  534
successor tasks  59–63, 180–182

applying color to  180, 182
for cross-plan links  484–487
definition  534
external  484
identifying in a plan  487
start/end dates  191

summary tasks 
See also task durations; tasks
changing appearance  374
default scheduling mode  56
definition  535
demoting to tasks  58
displaying for projects  66
editing durations  56
inserting in task lists  58
linking  62
outlining plans  56
scheduling manually  224–226
scheduling manually vs. automatically  226

support information  xviii

T
tab-delimited text files, exporting project 

data to  454
tab-delimited text, pasting into other 

programs  447
table fields, reordering  416–417
tables  25, 308–309 

See also Cost table
active, identifying  295
adding columns  312
adding to reports  410
built-in  311

551

tables



tables (continued)
changing design  417
changing layout  417
copying between plans  424–426
copying data to another program  446
copying to/from global 

template  424–427
creating custom fields  310
definition  535
Field List pane  415–417
field order  416
in reports, applying styles  141
in reports, formatting  141
selecting information to include  417
sorting  292, 295
task relationships  61
Variance  357

tabs (ribbon)  16–17 
See also individual tab names
collapsing and expanding  17
creating  437
resetting to defaults  438

tabular data
copying to other programs  449
pasting from other programs  449
selecting  448

task assignments  101
grouping by resource  118
viewing cost values  104

task bars
asterisks in names  375
excluding names from legends  375
switching to callouts in Timeline view  136

task boxes
modifying in Network Diagram view  389
styles  386–388

task calendars, definition  535
task-centric views  103

action indicators  109
specifying  314

task chains  181
task completion

extending progress on Gantt bars  167
recording percentage  166
setting progress on Gantt bars  167

task constraints 
See also specific constraint types
applying  193
categories  187–189
effects on scheduling  189–191
flexible  187–189
inflexible  187–189
removing  193
semi-flexible  187–188
types  188–189
using  191–192

Task Cost Overview report  359, 362
task costs  357–361

filtering  361
reporting  359
variances, displaying  361

task dependencies  59–60, 183
task duration 

See also summary tasks; tasks
abbreviations  51–52
elapsed  52
entering  54
estimating  52–53
fixed  244
in work calculations  102
values  50
in work calculations  102

task fields  See fields
Task Form

details  104
viewing/editing assignment details  107

task IDs, definition  535
Task Inspector  204–205
task links, adjusting relationships  183–185
task lists

inserting new summary tasks  58
inserting new tasks  49
product scope  49
project scope  49

task notes  67
Task Path formatting  180–182
task priorities, definition  535
task relationships  180, 183–186

adding lag time  184–186
adding lead time  184, 186
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changing types  185–186
finish-to-finish (FF)  183
finish-to-start (FS)  183
seeing using Task Path  180–182
showing or hiding in views  388
start-to-finish (SF)  183
start-to-start (SS)  183

Task Sheet view  25, 103
Task tab  17–18
task types

changing  200, 203–204
default  199
definition  535
and effort-driven scheduling  203
excluding from Gantt bar styles  379
fixed duration  199
fixed work  199
formatting text in Gantt charts  378
scheduling using  199–202
viewing  203–204

Task Usage view  26–27, 103, 330, 341
task values, breaking relationship to 

assignment values  341
task variances  354 

See also task costs
tasks 

See also summary tasks, task duration
actual work values  330
adding hyperlinks  68
adding notes  68
adding/removing resources  107–112
adding to Timeline view  135–137
adjusting working time  196–198
applying base calendar  197–198
assigning  254
assigning cost resources  114
assigning material resources  249
assigning to resources  102–107, 106
automatic scheduling  107–111
calculating costs  102
calculating work value  199
changing to critical  224
checking plan costs  118
clearing filtering  308
clearing grouping  301

cost resources  91, 114
critical paths  222, 282
definition  535
deleting  49
dependencies  59–60, 183
displaying relationships  180–182
displaying schedule details  204
displaying slack  224
editing work values  244
effort-driven scheduling  107–111, 113
entering actual values  168–169
entering completion 

percentages  165–166
entering milestones  55
entering names  48
filtering  305, 307
fixed costs  357
fixed-duration and contours  244
formatting predecessors  182
formatting successors  182
grouping  298, 301
highlighting using filters  308
ID number  48
inactivating  283–284
inserting in task lists  49
interrupting  194–195
leveling delay  271–272
linking  59–64, 183–186
marking as milestones  55
maximum Gantt bar rows  379
naming  48
notes  67–68
permanently renumbering  294
predecessors  59–63, 180–182
promoting to summary tasks  58
reassigning  252, 255
recording actuals  171, 334–335
recording remaining work  334–335
recurring  218–221
rejoining  195
relationships  59–61, 180–186
removing deadline dates  216
removing formats  69
removing hyperlinks  69
removing notes  69
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tasks (continued)
rescheduling  252, 342–343
scheduled  252
scheduled and baseline values  160
scheduling  254
scheduling automatically  48, 51, 64
scheduling manually  48, 51, 54, 63
scheduling modes  48
scheduling using constraints  186–193
scheduling using task types  199–202
sequences  59
setting deadline dates  215–216
slipped, identifying  354–356
sorting  292, 295
spanning working/nonworking times  54
splitting  194–195, 245
successors  59–63, 180–182, 191
switching between manual/automatic 

scheduling  64
synchronizing with SharePoint  511
tracking actual work  330–335
tracking progress in SharePoint  510
tracking remaining work  330–335
tracking timephased actual 

work  335–339
unassigning resources  102, 113
unlinking  63
unscheduled  252
viewing assigned resources  26
viewing cost details  116
viewing scheduling values  105
and work resources  91

teaching project management  525
Team Planner view, adjusting tasks in  252–255
Tell Me  6, 13
templates

creating from existing plans  22
definition  535
installed with Project  21
online  21
pinning to New page (Backstage view)  20
sources of  21
viewing available  21

for visual reports  461
within your organization  21

text
copying to other programs  447
formatting in Gantt charts  378
pasting as multiple columns  448

text boxes, adding to reports  410–411
text styles

changing in Timeline view  383
for timeline items  382

time, definition  535
time constraints  495–496
timeline bars

adding to Timeline views  384
changing date range  384
deleting  384
formatting text  382
moving tasks between  384

timeline dates, setting  384
Timeline views  24, 134–135, 138

adding tasks  135–137
adding timeline bars  384
checking finish dates  66
copying  141, 143–144
definition  535
displaying/hiding  28, 135
formatting items  383, 384
formatting task bars  383
formatting text  382
moving tasks between bars  384
panning a Gantt chart view  138
switching task bars to callouts  136
text styles  383
updates  6
zooming a Gantt chart view  138

timephased actuals
recording in Resource Usage view  341
recording in Task Usage view  341
tracking  335–339

timephased fields  335, 535
timephased grid

editing values  245, 337
entering actuals  338–339
navigating  337
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timescales
adjusting  26–27
adjusting in Gantt chart view  134
changing  138
definition  535

timing of practice tasks  524
Tool tabs  17
top-down focus  226
top-down planning  57, 535
total slack  222, 536
touch input, enabling  18
tracking

actuals  158–159
definition  536
overview  157
timephased actuals  335–339

Tracking Gantt view  354, 357
tracking progress  158–159

through current date  165
levels of detail  158
through a specific date  164
through status date  165
on tasks  164

Tracking table, recording task values  171
trade-off triangle  See project triangle
training focus of book levels  521–523
training, Project-related  504
triangle of triple constraints  495
Trust Center, legacy format settings  454
24 Hours base calendar  40
Twitter address for Microsoft Press  xviii

U
underallocated, definition  536
underallocated work resources  266
units 

See also work resources
assignment  102 
definition  536
in work calculations  102

units value  234
Update Tasks dialog box, recording task 

values  171
user groups, Project users  503–504

V
values, entering actuals for tasks  168–169
variable consumption rate, definition  536
variable-rate quantities, assigning to 

material resources  248–249
Variance table, displaying in Task Sheet 

view  357
variances  350

baselines  355
cost over time  361
definition  536
scheduled vs. baseline  163
tasks  354
work  361

VBA (Visual Basic for Applications)  427
copying macros  424–427
editing code  431–433

view label  14
view shortcuts  15
View tab  17
views

active  14
adjusting timescales  27
combination  14
comparison with reports  409
copying  141–144
copying between plans  424–426
copying to/from global 

template  424–427
creating  313–317
defining  316–317
definition  536
displaying combination  27
displaying reports simultaneously  31
displaying split  27
editing  315–317
Gantt chart  128–134
Gantt Chart  23
Gantt with Timeline  23, 128
multipage  145
page layout options  393
page setup options  393–394
panes  313
printing  144–146
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views (continued)
print options  393
project at a glance  141
report  14
resource-centric  314
Resource Usage  25
sheet  25
split  14, 26
switching between  27
switching to another table  27
task-centric  103, 314
Task Sheet  25
Task Usage  26
Timeline  24
using  23–25

Visio
exporting Project data as diagrams  459
reports  360
visual reports  460

Visio PivotDiagrams  460
Visual Basic Editor  431–433
Visual Basic for Applications (VBA)  427

copying macros  424–427
editing code  431

visual report templates  461
visual reports  360, 458–461

built-in  459
creating  461
Excel  460
in Excel and Visio  458–461
Visio  460

W
week height, changing in Calendar view  392
Windows Snipping Tool  141
Word, pasting data from Project  446
WordPad, pasting text from Project  447
work, definition  536
Work Breakdown Structure (WBS)

adding WBS codes to views  387
definition  536

work contours
applying to assignments  243
predefined, applying to assignments  245

work packages  47
work resources  79–81 

See also pay rates; resources; units
adjusting capacity  83
assigning to tasks  102–107, 112
availability  80
calculating assignment costs  84
cost  80
definition  536
deleting  81
displaying units  83
entering maximum capacity  82–83
entering names  81
entering pay rates  84–86
entering values  83
fully allocated  266
inserting in resource lists  81
managing costs  84–86
maximum capacity  82–83
maximum units  82–83
obtaining cost information  86
overallocated  266
removing from tasks  113
resource pools  470
setting up  80–81
and tasks  91
underallocated  266

work values, editing at task levels  244
work week, setting custom  42–43
working times

adjusting for tasks  196–198
customizing  41
making adjustments to  41

X
XML files, saving project plans as  454
XPS files, exporting plan views as  396

Z
Zoom Slider  15
zooming Gantt chart views from Timeline 

views  138
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